
   
– Getting Started

 

Citavi helps you with all research tasks,  

from searching for sources, to knowledge organization 

 and task planning, to creating a final publication. 
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1 Setting Up 
 Install After downloading, double-click Citavi5Setup.exe to 

begin the installation. The Word Add-In and the Pickers (for 

Firefox, Internet Explorer, Google Chrome, and Adobe Acrobat 

and Adobe Reader) are automatically installed as well. Pickers 

let you easily copy information from web and PDF documents. 

 Functionality The number of references you can save in a 

project depends on if you are using Citavi Free or a licensed 

version. Citavi Free lets you save up to 100 references per 

project, while a licensed version allows you to save up to 

100,000 references per project. 

 Obtaining a License You can purchase a license in our 

online shop at www.citavi.com/shop. If your college or univer-

sity offers a site license for Citavi, you can request your free li-

cense key at www.citavi.com/sitelicenses.  

 Enter License Key You will receive your license key di-

rectly from Swiss Academic Software by email. Select the en-

tire text of the license key message and copy it to the Clip-

board (Ctrl+C). Then, on the Citavi Welcome Screen, click Li-

cense > Enter a license key. The license assistant will explain 

the rest. 

 

 Create a New Project On the welcome screen, click New 

Project. 

Give the project a unique name (for example, City Planning 

Semester Project and click OK.  

By default Citavi saves your projects in the folder  

Documents\Citavi 5\Projects. 

 Hint: Set up Backups Citavi automatically saves your 

changes, so you don't have to remember to do so yourself. 

Whenever you close a project, Citavi saves a backup of it un-

der Documents\Citavi 5\Backup. The file name includes the 

name of the project, the date, and the time the backup was 

created. To increase the number of backups and change the 

folder for backup copies, click Tools > Options > Folders.  

If you need to restore a project from a backup, simply double-

click the file. 

Backup copies do not include files attached to your project. Be 

sure to regularly backup the entire Documents\Citavi 5 folder 

on an external drive. 

 

2 Adding and Navigating  
Citavi consists of three workspaces: the Reference Editor, the 

Knowledge Organizer, and the Task Planner. 

Citavi offers 35 reference types to handle all your references 

properly.  

 Add a Reference Click Reference on the toolbar and select 

the appropriate reference type. 

 

 Hint: Reference types How references appear later on in 

your bibliography depends on the reference type that’s used. 

Which reference types are available? Click the reference types 

that interest you to read descriptions of them. You can drag 

the reference types that you use most often to the favorites on 

the left. 

 Enter Information As you enter information, click Quick 

Help on the right to show helpful descriptions: they show you 

how to best use Citavi. Some fields also have clickable labels 

(if it’s blue, you can click it!). If you click Author, for example, 

you get an author editor that can handle complex names: 

 

Simple names can be entered directly (note the semicolon be-

tween authors): Miller, Peter M.; Smith, Jane  

The Contents tab lets you save abstracts, tables of contents, 

ratings , and evaluations.  

 Hint: Retrieve by ISBN, DOI or PMID As long as you 

have an active Internet connection, you can quickly add refer-

ences with an ISBN number, DOI name, or PubMed ID.  

Click                    and enter the identifier, and then click Add. 

Citavi downloads the bibliographic information for you. 

 Special Case: Chapters in Edited Books, etc. First, add 

the Edited Book (or Conference Proceedings, etc.) and enter 

its information. Then click Add contribution. When you format 

your publication, Citavi automatically pulls the right infor-

mation from each reference. 

 

 Navigate Click the arrows  to browse through your 

references. Click Back        to return to previously viewed ref-

erences. 

 Table View To see a handy overview of all your refer-

ences, click           . You can choose the columns to display 

and sort by. 
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3 Searching for Sources 
You can search over 4700 library catalogs, bibliographic data-

bases and more right from within Citavi. 

 Add a catalog Make sure you have an Internet connection, 

click Online search, and then click Add database or catalog.  

  

 

(Note: if you see “Available online: 0”, then the Internet con-

nection is not working correctly.)  

In the Name field, enter a key word, such as “London” to find 

catalogs in London. This finds the London Public Library, the li-

brary of London Metropolitan University, and more. Select the 

catalogs you want, and then click Add. Continue entering 

search terms until you have added all the catalogs you want, 

and then click Close to finish. 

 Run a Search Select the catalogs you want to search. You 

can select more than one catalog at a time. If you enter more 

than one search word, Citavi will search for results containing 

all of the search words. Pay attention to the Quick Help texts: 

they give you tips for building your search. Click Search to run 

the search. 

 

 Add Search Results Citavi presents the search results as 

a list. If the search didn’t find what you want, try again with 

different search terms. Then select the references you want to 

add, and click Add to project. 

 Cancel Selection The references you add to your project 

are automatically applied as a selection (a subset of your ref-

erences), so the others are hidden. This makes it easier to 

work with just the new references, for example to review and 

create tasks for them (see section 5). To see all references, 

click Cancel selection in the status bar. 

 

 Viewing Search Results Later On You can view a set of 

search results imported at a given time by clicking the auto-

matically added entry in the Import Groups column. 

 
 

 

4 Checking Information 
When you add reference information using the Online Search, 

the Pickers, or the ISBN, DOI, PMID feature, be sure to check 

the information that was automatically added to your project. 

 Check the Reference Type How your references appear in 

your bibliography depends on the citation style and the refer-

ence type. After importing reference information, double-check 

that the reference type is correct. To change a reference type, 

click the blue label.  

 

 Correcting Names Many databases export author names 

in capital letters or in the wrong order. Right-click the name 

and select the Edit option to make changes. 

 

5 Using the Pickers 
Pickers are extensions for Internet Explorer, Firefox, Google 

Chrome, and Adobe Acrobat and Adobe Reader. 

The Pickers make it easy to add Internet documents to your 

project.  

 Add a Webpage Make sure Citavi is running. To add a 

webpage to Citavi, load the page, then right-click anywhere in 

the browser window. Click Citavi Picker > Add webpage as ref-

erence. Citavi adds it to the current project as an Internet 

Document and copies the bibliographic information, if availa-

ble. (If the page doesn’t include it, you’ll have to enter it your-

self.) 

 Hint: Save Webpage as PDF Webpages often disappear 

without warning. To make sure you always have a copy of the 

text, you can save a PDF of the page. In the Preview, load the 

page, and then click Save as PDF.  

 Add a PDF Document The Picker for Adobe can not only 

add PDF documents as references, but it can also save the PDF 

files, too. Citavi adds a PDF as an Internet Document, extracts 

the bibliographic information from the PDF, and then links the 

PDF file as a Local file. 

 Annotate Documents and Excerpt Quotations Read 

webpages, e-books, and PDF files in the Preview. PDF docu-

ments can be annotated, and you can convert webpages and 

e-books to PDFs for this purpose. Just click Save as PDF.  

Excerpt text passages and images as quotations. Make sure to 

enter the page number if it does not appear automatically. 

Create tasks for individual passages, such as Examine and As-

sess or Discuss. 

With a single mouse click, you can jump to annotations in a 

PDF file from Citavi or the Word Add-In. Additional information 

can be found at www.citavi.com/pdf-guide. 

 Hint: Remove Line Breaks Text passages from PDFs of-

ten include hard line breaks. To get flowing text, double-click a 

quotation, etc. in Citavi to open it, and then press 

Ctrl+Shift+Space. 
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6 Planning Tasks 

Photocopy, Verify bibliographic information, and Read are just 

a few of the tasks you can assign to a reference.  

 Assign a Task to a Reference In the Reference Editor, on 

the Tasks & Locations tab, click Task. 

 Print a Task List To get an overview of all your tasks, in 

the Task Planner, click Task list. A printable Task List is cre-

ated. 

 

 Hint: Create a Project Task In the Task Planner, you can 

also create Project tasks, which do not apply to a specific ref-

erence. This is good for major deadlines, deliverable dates, 

etc. 

7 Creating an Outline 
It’s easy to create an outline for a paper with Citavi’s catego-

ries. You can assign categories to quotations and thoughts you 

have collected to better structure your paper. This is very 

helpful later on while writing. 

 Create a Category System In the Knowledge Organizer, 

click New category or New subcategory:  

 

Name the category, and continue adding new categories and 

subcategories to match the structure of your paper. 

 Hint: One Project, Multiple Publications Use the top 

level of your category system for the names of individual pub-

lications. Enter the sections for each publication as subcatego-

ries. 

 Assign Categories You can assign one or more categories 

to every reference, quotation, and thought in your project. 

This lets you view only the items relevant to a particular sec-

tion later on when you are writing your paper. Assign catego-

ries to references in the Reference Editor on the Context tab. 

To assign categories to a quotation or idea, double-click it and 

then enter the category in the corresponding field.  

 Modify Your Category System It’s normal to need to re-

vise and change your outline as you progress. Just select a 

category and use the controls to move it to its new place in 

the system. (You can also drag a category to move it.) 

 

The changes automatically apply to all items in your project 

assigned to the category. 

 

 

8 Organizing Knowledge 
You can save as many knowledge items — text and image 

quotations, thoughts, and comments — in Citavi as you need. 

The Knowledge Organizer helps you manage your collected 

knowledge. 

 Add Text Quotations You can save quotations from the 

Preview as described in section 5. Of course, you can also add 

quotations manually if you don’t have a source as a file on 

your computer. Choose the right kind of quotation:  

Direct quotation for a verbatim quotation, copied word-for-

word; Indirect quotation for the author’s thoughts in your own 

words; Summary for a heavily condensed version in your own 

words; Image or file quotation for images and audiovisual me-

dia; Comment for your opinions and notes about a statement 

by the author. 

In the Reference Editor, on the Quotation, Comments tab, click 

New and then select the quotation type. Enter the Page range. 

Click Core statement to enter a concise rewording of the main 

idea of the quotation. 

 Add Image Quotations Image and file quotations work 

the same way as text quotations. You can enter a Description 

and Caption as well. When you insert the image quotation into 

your document, the caption will appear underneath it. 

 Add a Thought You’ll find the light bulb    everywhere in 

Citavi. Use it to jot down Thoughts at any time. If you have 

handwritten notes, scan them in or photograph them with a 

digital camera, and then save as an image thought. 

 Create Associations Assign categories (see section 7), 

keywords, and groups to your knowledge items. Use catego-

ries for the sections in your paper and keywords for creating 

associations based on content. Groups can be used to organize 

knowledge items in a way unrelated to their content. 

 Get an Overview In the category tree, click a category to 

see the knowledge items that are assigned to it. You can com-

pare what different authors have said by selecting multiple 

quotations and looking at the content of the quotations in the 

Preview. 

 Sort Knowledge Items You can arrange knowledge items 

in a logical order to structure the flow of ideas in your planned 

paper and make it easier to write. Select a knowledge item 

and use the arrows to move it up or down. 

 

When you have a lot of knowledge items, you can use Sub-

headings to subdivide a category. 
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9 Writing with Word 
With Citavi’s Add-In for Word you can enter references and 

quotations into your document formatted exactly as your cita-

tion style prescribes. The bibliography is updated in real time 

to match. 

Do you work with Writer or a TeX editor? Please see our user 

manual: www.citavi.com/manual5 

 Assign a Project to Your Document Open a file in Word. 

On the Citavi ribbon, click Citavi pane. Select a project to as-

sign to the document.  

 Select a Citation Style To change citation styles, on the 

Citavi ribbon, click the Citation style dropdown menu. Click 

Add citation style. You can search for styles by name or cita-

tion system. 

It’s important that you decide whether you want to use a foot-

note style or an in-text citation style before you start writing. 

You can switch styles later on, but only within the same type 

of style. 

 Insert Categories and Knowledge Items If you used 

categories to structure your knowledge items (as described in 

section 7), insert your categories as headings. Right-click a 

category on the References or Knowledge tab in Word. Click 

Insert as heading to insert the category as a heading at the in-

sertion point.  

 Hint 1: Quickly Create a Rough Draft Instead of insert-

ing individual chapters, you can use the option Insert catego-

ries and knowledge items to quickly create a rough draft of 

your paper. This lets you draw on the work you’ve done in 

Citavi when you begin writing your paper in Word.  

 Hint 2: Insert an Outline from Citavi You’d rather only 

insert your outline and add quotations yourself while you 

write? Right-click a category, point to Insert categories and 

knowledge items, and then clear the Include knowledge items 

checkbox. Your category system will then be inserted using 

Word headings. On the Chapter tab, you can view and insert 

the references and knowledge items for the chapter in which 

the cursor is located.  

 Insert References 

On the References or 

Chapters tab, select the 

reference you want to 

insert. Either click In-

sert or double-click the 

reference. 

 Insert Quotations 

or Thoughts On the 

Knowledge or Chapters 

tab, select the quota-

tion or thought you 

want to insert. Either 

click Insert or double-

click the knowledge 

item. 

 Change the Form 

For in-text citation 

styles using the author 

and year format, you 

can easily change the 

format of the citation.  

 

Options include (Doe 2013), Doe (2013), Doe 2013, only Doe 

or only 2013. To choose an alternate form, select the refer-

ence and click Insert advanced. Alternatively, you can right-

click an already inserted reference. In the shortcut menu you 

can then select the form you want to use.  

 Enter Page Numbers If you insert quotations from your 

project, Citavi will insert the page numbers automatically. Al-

ternatively, you can insert a reference and then add the page 

numbers. On the References tab, select a reference. Either 

start typing the page number or click Insert advanced and en-

ter the page numbers in the Page range field.  

Do not add prefixes or suffixes such as pp. 12-14. Your cita-

tion style will do this for you. 

 Entering Multiple Citations First, insert the first refer-

ence into your document. Then, place the insertion point in the 

reference you just inserted. Insert additional references. De-

pending on the citation style, you will end up with a citation 

that looks like (Doe 2013, Miller 2013, and Smith 2010) or 

[14-16]. 

 Editing Multiple Ci-

tations Select the multi-

ple citation in the text. 

Click the Citations tab. 

Near the bottom of the 

pane you can delete unwanted references by clicking the     or 

change the order of citations with the arrows.  

10 Project Bibliographies 
Sometimes all you need is a simple list of references. 

 Print Project Bibliographies On the File menu point to 

Print or save project bibliography and then select Print in cur-

rent citation style. This will generate a list of the references 

currently displayed in the current citation style. 

 Select References If you want a list of all the references 

in your project, continue to step . If you only want one ref-

erence or a small number of references to appear in the biblio-

graphy, select them using the Ctrl key. Then right-click one of 

the selected references and select Apply as selection. You can 

use the Filter      or Search features to create a larger selec-

tion. 

 Change the Sort Order As a default, Citavi sorts all refer-

ences alphabetically and then by year. To change the sort or-

der, right-click the list of references. Click Sort and then set 

the sort order the way you want it.  

 Change the Citation Style On the Citation menu, click Ci-

tation style, and then click Browse citation styles. After that 

click Find and add style.  

 Choose what Your Bibliography Should Include To 

create a list of references grouped by specific criteria, click 

Print grouped or Save grouped. To create a list of references 

with quotations, abstracts, evaluations, etc., click Print anno-

tated or Save annotated. 

? More Information and Help 
Download:  www.citavi.com/download 

Manual:  www.citavi.com/manual5  

Support:  www.citavi.com/help 

http://www.citavi.com/support

